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may well be the program’s perfect inter-
action with the desktop. 

You can concentrate on the job in hand
and simply forget about trivial tasks, such
as how to open files. Simply drag a file
from the desktop, an FTP site you are
accessing in Konqueror or even from a
local directory currently on view and
drop it into an active Kate window – and
you are up and running. You can then

view the open file and start the work that
you have in hand. 

No need to worry about installing this
text tool as Kate belongs to the basic KDE
package kdebase. You might also like to
install the kdeaddons which will give you
access to the various plugins. 

But you need to launch the program
before you can load a file. You can either
launch Kate via the Start menu (Office /
Editors / Kate) or the command line. The
latter option is particularly useful for
opening files directly from the Web. In
this case you can connect to the Internet
and use your favorite terminal emulation
(how about Konsole?) to type a line such
as the following: 

kate http://linux01.gwdg.de/U

~steufel/index.html &

This should give you access to the index
file on Stefanie Teufel’s home page, as
you can see in Figure 1. Of course you
will be working with a local copy of the
HTML code.

If you need more information on Kate’s
comamnd line prowess, you can satisfy
your curiosity by typing kate --help. The
kate --help-kde command is nice feature
that tells you how to set the content of a
(--caption) or even customize the icon of
the program. 

A Question of Taste
You can use the Settings / Configure Kate
menu to tell Kate all about your personal
preferences, in regard to color schemes
for editing files, indenting and similar
actions. Figures 2a and 2b show the
dialog boxes for KDE 2 and 3.

The General Options section does
exactly what its name suggests. If you
want to restore the frames and views
exactly as you left them in the previous
editing session (Restore View Configura-
tion), and optionally open the last file

Linux Editors are ten a penny.
Whether command line or GUI
based, the wide selection ensures

that everyone will find something to suit
their individual needs. Even if you have a
personal favorite, it may be worth your
while to take a second look at Kate
(“KDE’s Advanced Text Editor”). 

One of Kate’s major features (and this
is true of every KDE Kernel application)

Thanks to syntax highlighting and similar tricks, editing with KDE’s “Swiss Army

Knife” Kate can be fun. The editor can even cope with simple programming
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KDE Standard Editor Kate

Let’s Edit

In this column we present tools, month by
month, which have proven to be especially
useful when working under KDE, solve a
problem which otherwise is deliberately
ignored, or are just some of the nicer things
in life, which – once discovered – you
wouldn’t want to do without.
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you edited when you relaunch
Kate – this is where you will find
all the options that you need.

If you use KDE 3 you can
additionally decide to edit any
files you wish to open in a single
(Kate MDI) window or separate
(Kate SDI) windows. If you are not
sure what all these options mean,
you can simply right click on the
text. The drop-down menu that
then appears shows a single
“What’s This?” help item, as you
can see in Figure 2b.

The next major item, Editor, affects the
way content is displayed inside the Kate
windows, allowing you to set the Colors
and Fonts. However, you can also use this
option to set your preferences for one of
Kate’s highlights – color display for
source code that can be specially adapted
to suit a large number of programming
languages, such as C/C++, Java,
Python, Perl or HTML. And it this Syntax
Highlighting feature that makes Kate a
fairly useful programming tool.

Highlights Cheaper by the
Dozen
You can use Highlighting to define how
and what Kate highlights. The dialog box
contains two tabs: Defaults (or Default
styles in KDE 3) and Highlight Modes.
The first of these options allows you to
modify the appearance of common
elements and select a color scheme and
typeface (bold, italic) for comments,
strings and data types in your program
code. Take your time with these settings –
careful planning can make your life easier

when programming or designing web
sites by providing you with a clear
overview of the source code.

The Highlight Modes tab (see Figures
3a and b) allows individual settings
depending on the selected programming
or markup language. But don’t panic –
you do not need to individualize all the
available options. Kate will simply use
defaults for any elements that you have
not individually configured.

Start by selecting the programming or
markup language in the drop-down menu
Highlight at the top of the dialog box
whose elements you need to redesign.
Kate immediately shows the file suffixes
and MIME types that will be assumed to
be written in this language. Then use
Item Style (Context Style for KDE 3) to
select the element types for the current
language whose aspects you would like
to change. 

If you are running KDE 2 you can use
the drop-down menu under Item in the
Item Style area (Figure 3a); KDE 3 offers a
table whose cell contents can be modified
by mouse click (Figure 3b).

If all these options are giving
you a headache, it might be useful
to take a look at an example. To
change the appearance of HTML
comments in Kate, select HTML in
the drop-down menu Highlighting.
For KDE 2 you need to select Com-
ments in the Element drop-down
(Figure 3a). Now click on the color
buttons to define a color for dis-
playing HTML comments and
check the typefaces you require.
KDE 3 also offers the same set-

tings, but in a more organized fashion
(see Figure 3b) allowing selections within
the drop-down menu for individual lines.

You can also switch highlighting modes
on the fly via the Document / Highlight
Mode menu item. The developers even
went to the trouble of categorizing the
modes by main areas of use such as
Sources for the classical programming
languages like C, C++ and Java or
Markup for markup languages like HTML
or XML.

Those Configuration Options
Keep on Coming
Like the Editor / Edit option in the Kate
configuration dialog box (Figure 4; the
corresponding dialog in KDE 3 has simply
dropped one or two confusing options). In
addition to the standard functions such as
setting automatic line wrapping or the
stripping of whitespace at the end of lines,
Kate also offers a few gimmicks such as
the Smart Home item. If you activate this
function, the cursor moves to a position
in front of the first character, instead of
moving to the beginning of the line.

Figure 1: Out of the Internet into the Editor

Figure 2a: Getting sorted: The Kate Configuration Menu for KDE 2 … Figure 2b: … and KDE 3 is nicely organized



in other windows and the
toolbox), drag them out of
the Kate window and drop
them on the desktop as a
separate window.

Just as in Konqueror
you can split the applica-
tion windows in Kate to
form multiple editor sub-
windows. Split views (see
Figure 7) are available via
the menu items View /
Split Vertical and View /

Split Horizontal; a nice feature if you
need to compare or transfer text between
multiple documents.

The green dot in the status bar shows
the window containing the cursor. To
close a window you simply click on the
square icon in the tool bar.

If you need access to the command line
while editing, you will appreciate the fact
that you can embed a terminal emulation
window in the editor. 

To do so, you just select Settings /
Show Console (or Show Terminal
Emulator in KDE 3) in the menu, and
Kate will immediately display an

integrated console like the
one in Figure 8.

Daily Business
Working with Kate is not
much different from working
with any other editor. You
can modify, insert and copy
to your heart’s desire. If you
want to save the file you are
working on or possibly print
it, check out the File menu. If
you need to copy, insert or
search for something, check
out the Edit menu instead
(see Figure 9). This menu
also allows you to access a
specific point in the current
document Goto line... or to
backtrack to a former version
using Undo.

This is the place to look for
those search functions. One
of Kate’s special features is
the Find Next option that
allows you to continue to
search for a search key you
entered previously. Also the
corresponding function Find
Previous does the same
thing, only this time in the

opposite direction.
If you stumble across a few typos while

browsing a document, you can use Kate’s
integrated spellchecker to check those
documents with purely textual content
(Figure 10). The tool you need for this job
is accessed via the Edit / Spelling... menu
in KDE 2 and via Tools / Spelling... in the
Kate version for KDE 3.

It is just as easy to specify the format
when saving the current document – the
options are Macintosh, Unix or DOS-Text.
The difference between these three is the
end-of-line character, which is either CR,
LF or both. Just let Kate know how you
want to handle this point via Document /
End of Line.

One of Kate’s useful features is the
option of bookmarking the documents
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Figure 3a: Defining the appearance of comments
in HTML documents with KDE-2

Figure 3b: KDE 3’s configuration dialog is much tidier .
Giving a cleaner layout overall

Figure 5: You can choose between files already opened…

Figure 6: … or files at other locations on your machine

CR/LF:“Carriage Return”(originally referred
to the carriage on a typewriter) and “Line
Feed”are the two ASCII characters that are
embedded in a file to indicate the end of a
line.They are normally invisible in text editors
apart from the obvious effect of starting a
new line.

GLOSSARY

Figure 4: Line Wrapping and Brackets

Points of View
One of the major reasons for using Kate is
the number of options for displaying or
accessing files. This immediately
becomes apparent if you open a file – as
mentioned at the outset of this article.
The left-hand side of the Kate window
provides two tabs with other variants
(Figure 5): a file list showing the cur-
rently opened files and the file selector
that allows for easy browsing of the file
system and helps you to locate the
required files (Figure 6).

Incidentally, in KDE 3 you can click on
the thicker border of these cards (just like



various actions and activities. In KDE 2
you simply select Settings / Configure
Key Bindings… and in KDE 3, Settings /
Configure Shortcuts. KDE 3 additionally –
and confusingly – offers another setting
in the configuration menu (Settings /
Configure Kate.). The Editor / Keyboard
item can only be used to configure key-
board shortcuts for cursor movements in
the current document, whereas Shortcuts
refers to the application itself (opening
and closing files, spell checking and so
on. If you happen to be too lazy to define
your own preferences, you can refer to
Table 1 for an overview of default key-
board mappings.

Plugged in
Plugins make Kate a
special editor. The
developers decided
on this design to
make the editor as

quick as possible and to maintain a small
footprint on the one hand, and to provide
as much functionality as possible for the
users on the other hand. This allows the
users freedom of choice on the amount of
ballast that they want to load when
launching Kate.

You can select the plugins Kate should
load for you by accessing Settings / Con-
figure Kate / Plugins / Manager (Figure
12). If this window is empty, you will
need to load the plugins by installing the
kdeaddons package.

To load a plugin (provided it has been
installed and is recognized by Kate), you
simply click on the plugin’s name in the
Available Plugins section, and then on
the right arrow button. The plugin imme-
diately appears in the Loaded Plugins
area on the right. 

To remove a plugin simply select its
name and click on the left arrow button.
To immediately activate a plugin, simply
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you are working on. Bookmarks in the
text allow you to jump quickly to a pre-
defined point. First, select View / Show
Icon Border in the menu. You can left
click on this column to attach a paper clip
(Figure 11). Your bookmarks are then
listed with the line number and a text
excerpt under Bookmarks in the menu,
where you can select them directly.

Just like
most KDE
programs
Kate allows
you to assign
keyboard
shortcuts for
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Figure 7: Different viewpoints in split view mode Figure 8: Kate and Konsole

Figure 9: Some items in the
Edit menu for KDE 2 have
found a new home in KDE 3 Figure 10: Now, how do you spell that?

Figure 11: Virtual bookmarks Figure 12: Choosing a plugin



click on the Apply button; you will be
able to work with the selected plugins
immediately.

If a plugin offers some other additional
configuration options, as in the case of
Insert Command Plugin, you can select
these options as a subitem of the Plugin
configuration item. The subordinate item
for the plugin, Insert Command allows
you to set the number of commands that
Kate will place in history.

The plugin itself inserts shell output in
the current document. You can launch
the plugin via the Edit menu. Just select
the Insert Command, to display a dialog
window like the one in Figure 13, where
you can enter the desired command and
the directory where you want it to run.
Kate will take care of everything else, as
you can see in Figure 14.

If you intend to use Kate for editing
HTML documents, you might also be
interested in the Kate HTML Tools. This
plugin provides the additional HTML Tag
functionality via your Edit menu. If you
select this item, a window like the one in
Figure 15 appears, where you can type
the name of an HTML tag (such as title).
Kate will then take care of placing the
necessary parentheses, start (<title>)

and end tags (</title>) at the current
position in the document. HTML authors
will be pleased that the developers have
assigned the keyboard shortcut [Alt -] to
this function.

KDE 3 users will discover that the XML
plugin has already been integrated, but
this is the only new plugin available in
this version. C and C++ programmers
will find the “Kate OpenHeader” plugin
that adds the item OpenHeader in the file
menu useful. Selecting this item opens
the .cpp or .c file for the header file that is
currently being edited and vice-versa.

The Kate Project Manager adds a menu
called Project which you can use to main-
tain simple programming projects, while
the Kate text filter filters and thus
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Figure 14: Inserting the output from a configure script in a Kate document

replaces the text selected by reference to
a shell commmand entered via the new
menu item (Edit / Text filter..). But take
care using this plugin in KDE 3; when we
forgot to select a text passage to filter,
Kate crashed when running on SuSE 7.2.

Kate does not have a lot to offer in the
way of third-party plugins at present,
although a single plugin for Python pro-
grammers is available from [1]. The trick
is, to keep your eyes open. ■

Figure 15: Creating HTML tags made simple

[1] Third-Party-Plugins for Kate: http://www.kde.org/kate/3rdparty.html
INFO

Table 1: Default Keyboard Mappings 
[Ins] Toggles between Insert and Typeover modes. In 

Insert mode the editor writes the text entries at
the current cursor position and moves the text right
of  the cursor to the right. In Typeover mode the 
characters right of the  cursor are over written by 
the new text entries.

[Left arrow] Moves the cursor one character to the left.
[Right arrow] Moves the cursor one character to the right.
[Up arrow] Moves the cursor one character up.
[Down arrow] Moves the cursor one character down.
[Page up] Moves the cursor one page up
[Page down] Moves the cursor one page down.
[Backspace] Deletes the character left of the cursor.
[Home] Moves the cursor to the start of the line.
[End] Moves the cursor to the end of the line.
[Del] Deletes the character right of the cursor (or the 

selected text).
[Shift-Left Arrow] Selects the text one character to the left.
[Shift-Right Arrow] Selects the text one character to the right.
[F1] Help (not pre-defined in KDE 3).
[F7] Show Console.
[F6] Show Icon Border.
[Ctrl-F] Open Search Dialog box.
[F3] Continue Search forwards.
[Shift-F3] Search for previous instances of last search string.
[Ctrl-C] Copy the selected text to the clipboard.
[Ctrl-N] Create a new document.
[Ctrl-P] Print current document.
[Ctrl-F4] Close current editor window.
[Ctrl-R] Search and replace.
[Ctrl-G] Goto line…
[Ctrl-S] Save current document.
[Ctrl-V] Pastet content from clipboard.
[Ctrl-X] Cut selected text and copy to clipboard.
[Ctrl-Z] Undo last step.
[Ctrl-Shift-Z] Redo last step.

Figure 13: The Insert
Command plugin dia-
log box in KDE 2


